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About This Book

Audience

SAS Universal Viewer is designed for both experienced and inexperienced users. You 
can view or manipulate SAS data sets, or move SAS data sets to another application.

The only requirement for using SAS Universal Viewer is a Windows operating 
environment. A SAS license is not required.
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About SAS Universal Viewer
SAS Universal Viewer is an application for the Windows operating environment that 
enables you to view SAS data sets and other types of files without invoking SAS and 
without installing SAS on your computer. SAS Universal Viewer is a replacement for 
the SAS System Viewer, and it is available with Base SAS and as a free download from 
SAS. You can view, sort, and filter data sets, but you are not able to edit them.

1



Types of Files That You Can View with SAS 
Universal Viewer

With SAS Universal Viewer, you can view the following types of files:

• SAS data sets, including those that were created on platforms other than Windows

• SAS v5 transport files

• SAS programs, logs, and listings

• general text files

• HTML and other file types that open in Internet Explorer

Benefits of Using SAS Universal Viewer
SAS Universal Viewer provides you with ways to manipulate SAS data sets and other 
files. You can perform the following tasks:

• view data without the risk of changing file contents

• filter data to create specific subsets of data

• sort data to organize important information or to highlight important fields

How to Get Help for SAS Universal Viewer
Help for SAS Universal Viewer is delivered in the form of a user's guide. The user's 
guide is available from the Help menu in the product.

Accessibility Features of SAS Universal Viewer

Overview
SAS Universal Viewer includes accessibility and compatibility features that improve the 
usability of the product for users with disabilities. These features are related to 
accessibility standards for electronic information technology that are adopted by the U.S. 
Government under Section 508 of the U.S. Rehabilitation Act of 1973, as amended.

If you have questions or concerns about the accessibility of SAS products, send e-mail to 
accessibility@sas.com.

Applets and Plug-ins
SAS Universal Viewer does not require an applet or plug-in on the client system.
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Assistive Technologies
When pages use scripting languages to display content or to create interface elements, 
the information that is provided by the script is identified with functional text that can be 
read by assistive technology. Some exceptions include using JAWS for reading table 
controls and certain functional text, and collapsing and contracting nodes while 
navigating with JAWS.

Color
The interface is designed so that all information that is conveyed with color is also 
available without color.

SAS Universal Viewer does not override user-selected contrast and color selections and 
other individual display attributes. With the Windows High Contrast #2 built-in theme, 
the foreground text of the tabular list in the Properties tab is not initially visible. The 
text is readily visible with High Contrast #1 or the White or Black built-in themes.

SAS Universal Viewer does not use color coding as the only means of conveying 
information, indicating an action, prompting a response, or distinguishing a visual 
element.

SAS Universal Viewer inherits user settings for color and contrast.

Current Focus
In SAS Universal Viewer, some of the controls do not have focus during the navigation 
of the product.

Displaying Text
Textual information is provided through operating system functions for displaying text. 
The minimum information that is made available is text content, text input caret location, 
and text attributes. SAS Universal Viewer uses standard operating system functions for 
displaying text.

Disruption of Accessibility Features
SAS Universal Viewer does not disrupt any activated accessibility features that are 
offered by the operating system.

Document Organization
Documents are organized so that they are readable without requiring an associated style 
sheet. When style sheets are disabled, the information is still able to be read.

Electronic Forms
When electronic forms are designed to be completed online, the form enables people 
using assistive technologies to access the information, field elements, and functionality 
that is required for completion and submission of the form, including all directions and 
cues. Some exceptions include reading error messages and using JAWS to read labels.

Accessibility Features of SAS Universal Viewer 3



Flashing or Blinking Elements
SAS Universal Viewer uses no flashing or blinking elements except for the system caret.

Images
In most cases, alternative text is provided with images. Images are used consistently 
throughout the interface.

When bitmap images are used to identify controls, status indicators, or other 
programmatic elements, the meaning that is assigned to those images are consistent 
throughout SAS Universal Viewer performance.

Input Focus
A well-defined, on-screen indication of the current screen focus is provided by SAS 
Universal Viewer. The focus can move among interactive interface elements as the input 
focus changes.

Interaction with Other Applications
SAS Universal Viewer does not disrupt or disable accessibility features that are provided 
with other applications that are developed and documented according to industry 
standards.

SAS Universal Viewer does not disrupt or disable features of any operating system that 
are identified as accessibility features. The application programming interface for those 
features must be documented by the manufacturer of the operating system and be made 
available to the product developer.

Keyboard Considerations
SAS Universal Viewer is designed to run on a system that supports a keyboard. Product 
functions are executable from a keyboard where the function itself or the result of 
performing a function can be seen in text. Some exceptions include keyboard keys that 
are used to activate some controls, and keyboard keys that are used to activate cell 
values in summary tables.

SAS Language Concepts

SAS Data Sets, Tables, and Variables
A SAS data set is a file whose contents are represented in a format that is specific to 
SAS. In database management systems, a SAS data file is typically referred to as a two-
dimensional table.

SAS uses the term “observation” to refer to rows in a table. Each observation is one row. 
SAS uses the term “variable” to refer to columns in a table. Each variable is a column in 
a table. The data values for each variable describe the characteristics (attributes) of that 
variable for all observations. Each SAS variable can have the following attributes:
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• name

• data type (character or numeric)

• length

• format

• informat 

• label

SAS Libraries
A SAS library is a collection of related SAS files and is similar in concept to a folder. In 
directory-based operating environments, a SAS library is a group of SAS files that are 
stored in the same directory and accessed by the same engine. Other files can be stored 
in the directory, but only the files with file extensions that are assigned by SAS are 
recognized as part of the SAS library.

SAS Formats
SAS formats control the way that SAS data is displayed. For example, for the variable 
COST, the format might be DOLLAR10.2. This format displays the value of COST with 
a leading dollar sign and a maximum length of 12 characters that includes two decimal 
positions. SAS Universal Viewer applies formats by default.

SAS Informats
An informat is an instruction that SAS uses to read data values into a variable. For 
example, the following value contains a dollar sign and commas: $1,000,000. To remove 
the dollar sign ($) and commas (,) before storing the numeric value 1000000 in a 
variable, you can read this value with the COMMA11. informat. Unless you explicitly 
define a variable first, SAS uses the informat to determine whether the variable is 
numeric or character. SAS also uses the informat to determine the length of character 
variables.

Variable Lables
A label is descriptive text that is associated with a SAS data set variable. Each variable 
or column in a SAS data set has a name that is used within the SAS code. Using a label 
to refer to a variable can make it easier to understand what a variable represents. SAS 
allows a label to be associated with each variable in a SAS data set.

SAS Language Concepts 5



6 Chapter 1 • Introduction to SAS Universal Viewer



Chapter 2

SAS Universal Viewer Interface

SAS Universal Viewer Main Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
The Main Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Using the Interface to View Libraries and Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
View a Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
View SAS Data Sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
View SAS Data Set Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
View Your SAS Data Set As a Series of Pages . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
View Large Data Sets without Paging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
View Text Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
View the Properties of a Text File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

View Other Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Open and Save Your Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

7



SAS Universal Viewer Main Window

The Main Window
When you invoke SAS Universal Viewer, a window appears that shows the name of the 
product and the release. After a few moments, the main SAS Universal Viewer window 
appears:

Display 2.1 SAS Universal Viewer Main Window

You can open libraries and files from the File menu or by entering the location in the 
Address box.

The following menus are available with SAS Universal Viewer:

File
enables you to open a library and open one or more files. The files open in a 
workspace.

Tools
enables you to set logon options, set the default use of formats, and set page breaking 
properties.

The Format tab in the Options window enables you to use user-defined formats that 
were created in SAS. To use these formats, you must first export the user-defined 
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formats to a formats file that has an XML file extension. Then import the formats into 
SAS Universal Viewer where they can be used to format values.

Window
enables you to select cascading, vertical, or horizontal tiling.

Help
enables you to access the SAS Universal Viewer 1.2: User's Guide.

The Address box enables you to open files and libraries by entering the file or library 
location. Address can be a local directory, a network path, or an Internet address. If you 
type an Internet address in the Address field, SAS Universal Viewer opens a browser in 
the workspace. You can have multiple workspaces open at the same time. Using multiple 
workspaces enables you to work on sets of files as a unit.

SAS Universal Viewer Main Window 9



Using the Interface to View Libraries and Files

View a Library
To view a SAS data set library, select File ð Open ð SAS Data Set Library, or enter a 
location in the Address field. The following window appears:

Display 2.2 SAS Data Set Library
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The Data Set window is displayed in the workspace and a Library tab is created. The 
library panel becomes populated with a list of SAS data sets that are located in the 
library. For each SAS data set, the name, number of observations, and the number of 
variables are listed. You can open multiple libraries and multiple files within the 
libraries. You can view a library at any time by clicking the Library tab.

View SAS Data Sets
If you double-click any SAS data set in the library, a table panel displays that is 
populated with the data from the SAS data set. You can open multiple data sets from the 
library view. Each data set is associated with a Table tab in the Data Set window. In the 
following example, the table tab INVOICE200 is selected:

Using the Interface to View Libraries and Files 11



Display 2.3 Data Set Tables

A Table menu and table toolbar enable you to view and manipulate the table that is 
displayed. The table status bar, located at the bottom of the table panel, displays row 
status, filter status, and sort status.

View SAS Data Set Variables
If you click any SAS data set in the library, a data set schema panel is displayed and is 
populated with data from the SAS data set that you selected. The data set schema defines 
the variables (columns) in the SAS data set and their properties. In the following 
example, the schema for data set HIST1 is displayed:
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Display 2.4 Data Set Schema Panel

View Your SAS Data Set As a Series of Pages
If your data set is very large, the data might take a long time to load or be too large for 
the amount of available memory. In either case, you can load and view the SAS data set 
as a series of pages.

Using the Interface to View Libraries and Files 13



To view the data set as a series of pages, select Tools ð Options ð Paging. The 
following window appears:

Display 2.5 Paging Tab in the Options Window

To break your data set into pages, make sure that the Break large data sets into pages 
box is checked. Enter a value in each of the fields. The second field contains the number 
of observations that you want to see on one page.

If you choose to break the data set into pages, you can sort and filter the data on each 
page, but you cannot sort and filter the entire data set. Paging enables you to view data 
from data sets that would normally be too large to view. If you need to sort and filter 
across the entire data set, you should deselect the Break large data sets into pages box 
on the Paging tab.

View Large Data Sets without Paging
You can view large data sets without paging by ensuring that the Break large data sets 
into pages box in the Paging tab is not checked.

When a data set exceeds the specified maximum data set size, the row status is 
highlighted and page controls become available.
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The following example shows the location of the page controls:

Display 2.6 Data Set Pages

You use the data set scroll bar to scroll the data within a page. You use the page controls 
to load new pages into memory. The up and down page control arrows without a bar are 
used to navigate one page at a time. The up and down page control arrows with bars at 
the tips of the arrow are used to navigate to the first and last page in the data set.

The Go to row page control enables you to go to a specific row in the table. Clicking the 
arrow to the right of Go to row opens a box in which you can enter the row that will 
become the first row of a page.

View Text Files
You can view text files such as SAS programs, log files, output listings, and other text 
files.

To view a SAS program, select File ð Open ð SAS Program. Select a file that has 
a .sas extension. You can view the file you select. To execute the SAS program, 
however, you must have a SAS license and you must open a SAS session.

Using the Interface to View Libraries and Files 15



The following example shows a SAS program called test-pgm.sas:

Display 2.7 Example of a SAS Program

To view a log file or a listing, select File ð Open ð Log or File ð Open ð List.

View the Properties of a Text File
You can view the properties of a text file by opening the text file and then clicking the 
Properties tab. You are able to view the attributes, metadata, and time stamps of the text 
file.
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The following window appears when you click the Properties tab:

Display 2.8 Properties of the test-pgm.sas Text File

View Other Files
You can view other files, such as Excel spreadsheets, by selecting File ð Open ð 
Other. Select the file you want to open.

Open and Save Your Workspace
You can open multiple files in your workspace. To open your workspace, select File ð 
Open ð Workspace. SAS Universal Viewer first closes all of the windows that are 
open in your current workspace. Files that are associated with the new workspace are 
then loaded. When you save a workspace, the files that are open are saved. By default, 
whenever you exit SAS Universal Viewer, the Viewer saves the last workspace that you 
used.

You can change the workspace settings by selecting Tools ð Option ð General. The 
General tab enables you to select workspace options.

Open and Save Your Workspace 17
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Apply or Remove SAS Formats
You can apply SAS formats to or remove SAS formats from columns in the data set you 
are viewing. Right-click to select a cell in the column for which you want to change the 
format. In the menu that appears, check or uncheck Format. The Format option acts 
like a toggle.

In the window, you can supply user-defined formats. These formats need to be created in 
SAS, exported to an XML formats file, and then imported to SAS Universal Viewer 
where they can be used to format values.
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Change File Associations
Perform the following tasks to set SAS Universal Viewer as the default application for 
opening files that have a specific extension:

1. Select File ð Open ð Other from the menu.

2. Right-click a file with the extension you want.

3. Select Open With from the menu.

4. Under Choose Program, select SAS.UniViewer as the program you want to use to 
open the file.

5. Check the box at the bottom of the selection list if you want SAS Universal Viewer 
to always open this type of file.

6. Click OK.

Copy and Paste to Other Applications
SAS Universal Viewer follows standard Windows copy and paste operations. You 
cannot edit tables, but you can copy the data from a table to other applications. You 
cannot copy row and column headings.
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Filter Data

Standard Data Filtering
Clicking Filter in the table toolbar opens the Filter Editor window:

Display 3.1 Filter Editor Window

You can use the Filter feature to subset data. In this example of standard data filtering, 
the first field contains the name of the filter variable, LASTNAME, which was chosen 
from the drop-down menu in the window. The drop-down menu in the second field 
establishes the relationship between the filter variable and the value that you enter into 
the third field. The fourth field enables you to select AND or OR to continue with the 
selection process. Clicking OK returns the filtered observations.

When you view a data set, you can select View ð Apply Filter to toggle the existing 
filter on and off.

Note: You can use CTRL-C to copy and paste a value from your table to the third field 
in the Filter Editor window. Select a value from the table before you click the Filter 
tab.

Advanced Data Filtering
To use the advanced filtering feature, click the Advanced tab in the Filter Editor 
window. Enter a column heading, select the data type, and click Insert. Select an 
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operator from the menu and click Insert. Select a date from the calendar and click 
Insert.

In the following example, the column HIREDATE is selected with a type of 
System.DateTime. The filter returns observations where HIREDATE is less than the 
value in the Date field. Note that you must click Insert after you make your field 
selections.

Display 3.2 Advanced Tab of the Filter Editor Window

Find Text in a Table
To find text in a table, enter the text you want to find in the Find box and then click the 

 icon. Click the icon again to find the next occurrence.

Hide Columns or Show Hidden Columns in a 
Table

To hide a column in a table, right-click any cell in the column that you want to hide and 
then select Hide from the menu.

To show a hidden column in a table, click the Show button. The Column Visibility 
window appears. All of the columns in the table are listed. Check the box to the left of 
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the column name to show the column in the table. Boxes that are not checked cause the 
columns to be hidden when you view the table.

You can also hide multiple columns by using CRTL-CLICK or SHIFT-CLICK to select 
the columns, and then clicking the Hide button to hide the columns.

Move a Column to a Different Position in a Table
To move a column to a different position in a table, drag the column heading to the 
desired location in the table.

Paging for Viewing Large Files
You can set the number of observations that will result in a page break in your SAS data 
set. To set the number of observations, follow these steps:

1. Select Tools ð Options from the menu.

2. Click the Paging tab.

3. Make sure that the Break large data sets into pages box is checked.

4. Enter the number of observations in the boxes of the Data Paging section.

5. Click OK.

Note: Deselecting the check box in the Paging tab enables the full data set to be brought 
into SAS Universal Viewer. You can then filter and sort the entire data set.

Prevent Column Scrolling
You can prevent one or more columns from scrolling horizontally. To prevent column 
scrolling, click a cell in the column that you want to remain stationary, and then click the 
Freeze button. The column that you selected, as well as all of the columns to the left of 
the selected column, will not scroll when you move the scroll bar to the right or to the 
left. Click Freeze again to allow scrolling.

Resize Columns
To resize a column, drag the column separator to the left or right between the table 
headings.

Save a Table
To save a table, select Table ð Save As from the Table menu.
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Save a Table as an XML or CSV File
To save a table in XML or CSV format, select Table ð Save As from the Table menu. 
Enter a filename, and then select XML or CSV from the Save as type menu.

Save, Print, or Close a Table
To save, print, or close a table, click the Table button. From the menu, select Save As to 
save the table, Print to print the table, or Close to close the table.

Select Data
SAS Universal Viewer uses standard Windows navigation:

• You can hold down the CTRL key and click multiple items to select them all.

• You can select all the data in a table by clicking CTRL-A or by clicking the empty 
box in the upper left corner of the table.

• You cannot select column headings in a table, but you can drag column headings to 
move a column to a different position in the table.

• To select an entire row in a table, click the row number. 

• To select an entire column in a table, hold down the SHIFT key and then click the 
first table cell and the last table cell. 

Sort a Table
Clicking a column heading sorts the table by that column. You can sort a table by any 
column, but you can sort only by one column at a time. Clicking the column heading 
works as a toggle. An upward facing arrow in the heading indicates that the data is 
sorted in ascending order, and a downward facing arrow indicates that the data is sorted 
in descending order. If your table is paged (loaded as a series of pages), then sorting 
columns applies only to the page of observations that you are viewing.

View a Large File without Paging
To view a large file without paging, follow these steps:

1. Select Tools ð Options from the menu.

2. Click the Paging tab.

3. Make sure that the Break large data sets into pages box is not checked.
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Values for the number of observations will still display, but these values are ignored. 
Deselecting the check box enables the full data set to be brought into SAS Universal 
Viewer. You can then filter and sort the entire data set.

4. Click OK.

View Column Labels
To view column labels in column headings, right-click any cell in the table and then 
select Display Labels from the menu. The Display Labels selection acts like a toggle, 
turning labels on and off.

If you do not have labels associated with column headings, then the variable name is 
displayed in the headings. To determine which columns have labels, click the Library 
tab and then select a table. Information about the table, including the labels, is displayed 
on the right side of the window.
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